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Universalis Configurator & Downloader (UCD Version 1.12) 

Λογισμικό Προγραμματισμού και Διαμόρφωσης της Συσκευής Universalis (Ver 203) 

Γενικά 
Η συσκευή Universalis είναι μια ολοκληρωμένη, ελεύθερα προγραμματιζόμενη διάταξη θερμικών εφαρμογών 

της  οποίας η λειτουργία μπορεί να καθοριστεί από τον αυτοματιστή- μηχανικό ώστε να υλοποιεί τον 

επιθυμητό αλγόριθμο της κάθε εφαρμογής. 

Ο προγραμματισμός της συσκευής γίνεται μέσω του λογισμικού Universalis Configurator & Downloader (UCD) 

και κλειδώνεται με 8-ψήφιο κωδικό . 

Δομή 

Η συσκευή Universalis διαθέτει 4 εισόδους αισθητηρίων θερμοκρασίας και 3 εξόδους ρελέ. Κάθε εφαρμογή 

μπορεί να χρησιμοποιήσει οποιεσδήποτε από τις 4 αυτές εισόδους και οποιεσδήποτε από τις 3 εξόδους ρελέ. 

Διαθέτει ακόμα 3 ενδεικτικές λυχνίες LED και μια οθόνη 3 ψηφίων. Οι ενδείκτες και η οθόνη μπορούν επίσης 

να ρυθμιστούν ώστε να ενημερώνουν το χρήστη ανάλογα με την εφαρμογή.  

Επίσης η συσκευή διαθέτει και μια πλήρη σειρά άλλων μονάδων που υλοποιούνται μέσω του 

ενσωματωμένου λογισμικού και μπορούν να διασυνδεθούν ώστε να εκτελεί την απαιτούμενη λειτουργία. 

Όλα τα παραπάνω στοιχεία ονομάζονται δομικοί λίθοι και ο αυτοματιστής μπορεί να τα χρησιμοποιήσει 

όπως επιθυμεί ώστε η συσκευή να εκτελεί τους απαιτούμενους ελέγχους και να λειτουργεί όπως αναμένεται. 

Διαμόρφωση 

Ο αυτοματιστής πρέπει να φανταστεί ότι έχει στα χέρια του τους δομικούς λίθους και να σχεδιάσει την 

εσωτερική διαμόρφωση της συσκευής διασυνδέοντάς τους μεταξύ τους.  Το λογισμικό UCD τον διευκολύνει 

σε αυτό.  Αφού καθορίσει τη διαμόρφωση του αυτοματισμού μέσω των συνδέσεων των δομικών λίθων 

μπορεί να προγραμματίσει τη συσκευή Universalis και να ελέγξει άμεσα την πραγματική της λειτουργία. 

Η διαμόρφωση καθορίζεται από την τιμή των παραμέτρων των δομικών λίθων. Κάθε δομικός λίθος μπορεί να 

πάρει συγκεκριμένες τιμές στις παραμέτρους του. Στην ενότητα δομικοί λίθοι παρουσιάζονται οι δυνατές 

επιλογές των παραμέτρων. Για λόγους ευκολίας στην ανάγνωση οι αναλογικές και οι δυαδικές τιμές των 

παραμέτρων έχουν αντικατασταθεί από τις παραπομπές στους αντίστοιχους πίνακες που φαίνονται 

παρακάτω. Σε κάθε περίπτωση το λογισμικό UCD σας επιτρέπει να εισάγετε μόνο τις επιτρεπτές τιμές των 

παραμέτρων. Δε χρειάζεται να θυμάστε τις επιλογές απ’ έξω. Η παράθεσή τους σε πίνακες γίνεται για λόγους 

ενημερωτικούς. 

Το λογισμικό UCD επιτρέπει επίσης στον αυτοματιστή να σώζει την κάθε διαμόρφωση και να διατηρεί αρχείο 

με τις υλοποιήσεις που έχει κάνει ώστε αργότερα να μπορεί να επαναχρησιμοποιήσει, ανακαλέσει, 

διορθώσει η μεταβάλλει τη λειτουργία της συσκευής. 
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Ασφάλεια 

Η διαμόρφωση που επινοεί ο κάθε αυτοματιστής κλειδώνεται εντός της συσκευής και είναι αδύνατο να τη δει 

άλλος που δε διαθέτει τον κωδικό ασφαλείας έστω και αν έχει το λογισμικό UCD. Με τον τρόπο αυτό η κάθε 

ιδιωτική ιδέα του αυτοματιστή που αποτελεί πνευματική του ιδιοκτησία δεν επιτρέπεται να κοινοποιηθεί σε 

άλλους. 

Ο κωδικός ασφαλείας αρχικά είναι 00,00,00,00 που σημαίνει ότι η συσκευή είναι ξεκλείδωτη. Όταν 

ολοκληρώσετε τους πειραματισμούς, την ανάπτυξη της απαιτούμενης διαμόρφωσης προτείνεται να αλλαχτεί 

ο κωδικός ασφαλείας. Για τον τρόπο αλλαγής του κωδικού συμβουλευτείτε το εγχειρίδιο της συσκευής  

Universalis.  

Όταν η συσκευή κλειδωθεί δηλαδή όταν ο κωδικός ασφαλείας αλλαχτεί από το 00,00,00,00 τότε 

δεν υπάρχει τρόπος εκ νέου μεταβολής του. Θα πρέπει να προχωρήσετε σε ολοκληρωτικό 

σβήσιμο των παραμέτρων και της διαμόρφωσής της με τη διαδικασία Reset που περιγράφεται 

Δεξαμενή αναλογικών επιλογών 

Τιμή Σημασία 
0 Είσοδος ανενεργή 

S1 Έξοδος S1 

S2 Έξοδος S2 

S3 Έξοδος S3 

S4 Έξοδος S4 

S1-S2 Διαφορά εξόδων S1-S2 

S1-S3 Διαφορά εξόδων S1-S3 

S1-S4 Διαφορά εξόδων S1-S4 

S2-S1 Διαφορά εξόδων S2-S1 

S2-S3 Διαφορά εξόδων S2-S3 

S2-S4 Διαφορά εξόδων S2-S4 

S3-S1 Διαφορά εξόδων S3-S1 

S3-S2 Διαφορά εξόδων S3-S2 

S3-S4 Διαφορά εξόδων S3-S4 

S4-S1 Διαφορά εξόδων S4-S1 

S4-S2 Διαφορά εξόδων S4-S2 

S4-S3 Διαφορά εξόδων S4-S3 

MAXM1 Δεσμευμένο για μελλοντική χρήση 

MINM1 Δεσμευμένο για μελλοντική χρήση 

CC[0] Δεσμευμένο για μελλοντική χρήση 

CC[2] Δεσμευμένο για μελλοντική χρήση 

CC[3] Δεσμευμένο για μελλοντική χρήση 

CC[4] Δεσμευμένο για μελλοντική χρήση 

CC[5] Δεσμευμένο για μελλοντική χρήση 

CC[6] Δεσμευμένο για μελλοντική χρήση 

CC[6] Δεσμευμένο για μελλοντική χρήση 

CC[7] Δεσμευμένο για μελλοντική χρήση 

CC[8] Δεσμευμένο για μελλοντική χρήση 

CC[9] Δεσμευμένο για μελλοντική χρήση 

Δεξαμενή δυαδικών επιλογών 

Τιμή Σημασία 
OFF Είσοδος ανενεργή 

TMC_1 Έξοδος TMC_1 

TMC_2 Έξοδος TMC_2 

TMC_3 Έξοδος TMC_3 

TMC_4 Έξοδος TMC_4 

TMC_5 Έξοδος TMC_5 

TMC_6 Έξοδος TMC_6 

TMC_7 Έξοδος TMC_7 

TMC_8 Έξοδος TMC_8 

AND_1 Έξοδος AND_1 

AND_2 Έξοδος AND_2 

AND_3 Έξοδος AND_3 

AND_4 Έξοδος AND_4 

OR_1 Έξοδος OR_1 

OR_2 Έξοδος OR_2 

OR_3 Έξοδος OR_3 

OR_4 Έξοδος OR_4 

NOT_1 Έξοδος NOT_1 

NOT_2 Έξοδος NOT_2 

NOT_3 Έξοδος NOT_3 

NOT_4 Έξοδος NOT_4 

MAX Δεσμευμένο για μελλοντική χρήση 

MAX Δεσμευμένο για μελλοντική χρήση 

MAX Δεσμευμένο για μελλοντική χρήση 

MIN Δεσμευμένο για μελλοντική χρήση 

MIN Δεσμευμένο για μελλοντική χρήση 

MIN Δεσμευμένο για μελλοντική χρήση 

XOR_1 Έξοδος XOR_1 

XOR_2 Έξοδος XOR_2 

XOR_3 Έξοδος XOR_3 

XOR_4 Έξοδος XOR_4 

STATE Κατάσταση ΟΝ/OFF συσκευής 
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παρακάτω.  

Σε περίπτωση που ξεχάσετε τον κωδικό ασφαλείας δεν υπάρχει δυνατότητα ανάκτησης της διαμόρφωσης της 

συσκευής. Μπορείτε όμως να σβήσετε ολοκληρωτικά τη διαμόρφωση, τις αρχικές τιμές και τον κωδικό 

ασφαλείας ώστε να χρησιμοποιήσετε τη συσκευή από την αρχή. Η διαδικασία Reset εκτελείται με βάση τα 

ακόλουθα βήματα. 

1. Διακόψτε την παροχή ρεύματος στη συσκευή 

2. Πατήστε και κρατήστε πατημένο το κάτω πλήκτρο. 

3. Τροφοδοτήστε με ρεύμα τη συσκευή. 

4.  Η συσκευή θα εμφανίσει το μήνυμα «---» και κατόπιν τη λέξη «Uer». 

5. Τότε αφήστε το κάτω πλήκτρο. Η συσκευή θα μηδενίσει όλα τα στοιχεία προγραμματισμού και θα 

πάει στην κατάσταση «OFF». 

Εν συνεχεία μπορείτε να προγραμματίσετε νέο κωδικό ασφαλείας και νέα διαμόρφωση. Ο κωδικός 

ασφαλείας έχει μηδενιστεί στο 00,00,00,00. 

Δομικοί Λίθοι 

Οι δομικοί λίθοι είναι τα στοιχεία αυτοματισμού που δίδονται στον αυτοματιστή προκειμένου 

διασυνδεόμενα να υλοποιήσουν τον αυτοματισμό που απαιτείται.  Στη συνέχεια θα εξηγηθεί διεξοδικά η 

λειτουργία και τα χαρακτηριστικά του κάθε δομικού λίθου. 

1. SENSOR 

Αυτός ο δομικός λίθος καθορίζει τον τρόπο λειτουργίας κάθε μίας από τις 4 εισόδους της συσκευής.   

 

Όνομα S1…S4 Παράμετροι Έξοδοι 

Σύμβολο 
 

 

1 1 

Επιτρεπόμενες Τιμές Εύρος τιμών 

Τιμή Σημασία -40˚C…+150˚C 

Πλήθος 
Λίθων 

4 0 Είσοδος ανενεργή  

  RSxx1k5 
Είσοδος αισθητηρίου 
τύπου RSxx1k5 

 

  KSxx1k0 
Είσοδος αισθητηρίου 
τύπου KSxx1k0 

 

  PSxx1k0 
Είσοδος αισθητηρίου 
τύπου PSxx1k0 

 

 

2. ΤHERMOSTAT 

Αυτός ο δομικός λίθος εκτελεί τη θερμοστατική λειτουργία. Η είσοδός του μπορεί να ρυθμιστεί ώστε να είναι 

η θερμοκρασιακή έξοδος του δομικού λίθου SENSOR (λειτουργία θερμοστάτη άνω ή κάτω ορίου) ή 

αριθμητική διαφορά θερμοκρασιακών εξόδων των SENSOR (θερμοστάτης διαφορικής λειτουργίας). Επίσης 

διατίθενται και άλλες διαθέσιμες τιμές εισόδων όπως εξηγούνται στον παρακάτω πίνακα.  

Ο κάθε διαθέσιμος δομικός λίθος TMC σχετίζεται επίσης και με 2 από τις τιμές χρήστη. Για παράδειγμα ο 

TMC-1 σχετίζεται με τις τιμές χρήστη Ρ00 και Ρ01. Όταν η τιμή που δέχεται από τη δεξαμενή αναλογικών 
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επιλογών υπερβεί την τιμή Ρ00 η έξοδός του γίνεται OFF. Η έξοδος ξαναγίνεται ΟΝ όταν η τιμή της δεξαμενής 

αναλογικών επιλογών πέσει κάτω από την τιμή Ρ01. 

  

Όνομα TMC-1…TMC-8 Παράμετροι Έξοδοι 

Σύμβολο 

 

1 1 

Επιτρεπόμενες Τιμές Εύρος τιμών 

Δεξαμενή αναλογικών επιλογών ON-OFF Πλήθος 
Λίθων 

8 

 

3. AND 

Αυτός ο λογικός δομικός λίθος εκτελεί τη λειτουργία “ΚΑΙ”. Η είσοδοί του μπορούν να ρυθμιστούν ώστε να 

είναι οι λογικές έξοδοι οποιονδήποτε λογικών δομικών λίθων της συσκευής. Η έξοδός του λαμβάνει την 

λογική τιμή ΟΝ όταν και οι δυο είσοδοι είναι ΟΝ. Όταν κάποια από τις δυο ή και οι δυο είναι σε κατάσταση 

OFF τότε και η έξοδος του δομικού λίθου AND είναι OFF. 

  

Όνομα AND-1…AND-4 Παράμετροι Έξοδοι 

Σύμβολο 

 

2 1 

Επιτρεπόμενες Τιμές Εύρος τιμών 

Δεξαμενή δυαδικών επιλογών ON-OFF Πλήθος 
Λίθων 

4 

 

4. OR 

Αυτός ο λογικός δομικός λίθος εκτελεί τη λειτουργία “Ή”. Η είσοδοί του μπορούν να ρυθμιστούν ώστε να 

είναι οι λογικές έξοδοι οποιονδήποτε λογικών δομικών λίθων της συσκευής. Η έξοδός του λαμβάνει την 

λογική τιμή ΟΝ όταν τουλάχιστον μια είσοδος του είναι ΟΝ. Όταν και οι δυο είσοδοι είναι σε κατάσταση OFF 

τότε και η έξοδος του δομικού λίθου OR είναι OFF. 

  

Όνομα OR-1…OR-4 Παράμετροι Έξοδοι 

Σύμβολο 

 

2 1 

Επιτρεπόμενες Τιμές Εύρος τιμών 

Δεξαμενή δυαδικών επιλογών ON-OFF Πλήθος 
Λίθων 

4 

 

5. NOT 
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Αυτός ο λογικός δομικός λίθος εκτελεί τη λειτουργία “ΟΧΙ”. Η είσοδός του μπορεί να ρυθμιστεί ώστε να είναι 

οι λογική έξοδος οποιουδήποτε λογικού δομικού λίθου της συσκευής. Η έξοδός του λαμβάνει την λογική τιμή 

ΟΝ όταν η είσοδος του είναι ΟFF. Όταν η είσοδος του δομικού λίθου είναι OFF τότε η έξοδός του γίνεται ON. 

Συνεπώς η έξοδος του δομικού λίθου NOT είναι αντίθετη της εισόδου του.  

 

Όνομα NOT-1…NOT-4 Παράμετροι Έξοδοι 

Σύμβολο 

 

1 1 

Επιτρεπόμενες Τιμές Εύρος τιμών 

Δεξαμενή δυαδικών επιλογών ON-OFF Πλήθος 
Λίθων 

4 

 

6. XOR 

Αυτός ο λογικός δομικός λίθος εκτελεί τη λειτουργία “ΑΠΟΚΛΕΙΣΤΙΚΟΥ Ή”. Η είσοδοί του μπορούν να 

ρυθμιστούν ώστε να είναι οι λογικές έξοδοι οποιονδήποτε λογικών δομικών λίθων της συσκευής. Η έξοδός 

του λαμβάνει την λογική τιμή ΟΝ όταν μια μόνο είσοδος του είναι ΟΝ. Όταν και οι δυο είσοδοι είναι σε 

κατάσταση OFF ή όταν και οι δύο είναι σε κατάσταση ΟΝ τότε και η έξοδος του δομικού λίθου XOR είναι OFF. 

  

Όνομα XOR-1…XOR-4 Παράμετροι Έξοδοι 

Σύμβολο 

 

2 1 

Επιτρεπόμενες Τιμές Εύρος τιμών 

Δεξαμενή δυαδικών επιλογών ON-OFF Πλήθος 
Λίθων 

4 

 

7. LED 

Αυτός ο δομικός λίθος καθορίζει τον τρόπο λειτουργίας του καθενός από τα ενδεικτικά LED της πρόσοψης της 

συσκευής. Η είσοδός του μπορεί να ρυθμιστεί ώστε να είναι οι λογικές έξοδοι οποιουδήποτε λογικού 

δομικού λίθου της συσκευής. Ο δομικός λίθος LED-1 είναι μονίμως συνδεδεμένος με τον δομικό λίθο R1, 

παρακολουθεί την κατάσταση του ρελέ 1 και δεν γίνεται να ρυθμιστεί ανεξάρτητα. Οι υπόλοιποι δομικοί 

λίθοι LED2 και LED3 ρυθμίζονται ανεξάρτητα ανάλογα με την τιμή της παραμέτρου.  

  

Όνομα LED1…LED3 Παράμετροι Έξοδοι 

Σύμβολο 

 

1 0 

Επιτρεπόμενες Τιμές Εύρος τιμών 

Δεξαμενή δυαδικών επιλογών 

- 

Πλήθος 
Λίθων 

3  

 

8. DISPLAY 
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Αυτός ο δομικός λίθος καθορίζει τον τρόπο λειτουργίας της αριθμητικής οθόνης της συσκευής. 

  

Όνομα DISPLAY Παράμετροι Έξοδοι 

Σύμβολο 

 

1 0 

Επιτρεπόμενες Τιμές Εύρος τιμών 

Δεξαμενή δυαδικών επιλογών 

- 

Πλήθος 
Λίθων 

1  

 

9. RELAY 

Αυτός ο δομικός λίθος καθορίζει τον τρόπο λειτουργίας των ρελέ εξόδου . Η είσοδός του μπορεί να ρυθμιστεί 

ώστε να είναι οι λογική έξοδος οποιουδήποτε λογικού δομικού λίθου της συσκευής. Η παράμετρος που 

καθορίζει τη λειτουργία του R1 ορίζει και την κατάσταση του LED1. Αυτοί οι δυο δομικοί λίθοι δε μπορούν να 

ρυθμιστούν ανεξάρτητα.    

 

Όνομα R1…R3 Παράμετροι Έξοδοι 

Σύμβολο 

 

1 0 

Επιτρεπόμενες Τιμές Εύρος τιμών 

Δεξαμενή δυαδικών επιλογών 

- 

Πλήθος 
Λίθων 

3  

 

Εγκατάσταση UCD 

Λογισμικό UCD τρέχει σε PC με λειτουργικό σύστημα. Οι απαιτήσεις σε χώρο του δίσκου και επεξεργαστική 

ισχύ είναι στοιχειώδεις.  

Αν έχετε το εγκαταστάσιμο UCD μπορείτε να κάνετε την εγκατάστασή του αποσυμπιέζοντας το αρχείο και 

τρέχοντας το setup. Εναλλακτικά αν έχετε το UCD portable δεν απαιτείται εγκατάσταση. Στην περίπτωση αυτή 

αποσυμπιέστε τα αρχεία του λογισμικού UCD σε έναν νέο φάκελο και τρέξτε το αρχείο UCD.exe. 

Φυσική σύνδεση 

Το υπό προγραμματισμό Universalis και το PC πρέπει να συνδεθούν μέσω της συσκευής διασύνδεσης C2S. Η 

συσκευή συνδέεται στο PC σε μια θύρα USB και από την πλευρά του Universalis στον συνδετήρα SIP στο πίσω 

μέρος. 

Βεβαιωθείτε ότι η συσκευή διασύνδεσης C2S έχει συνδεθεί και εγκατασταθεί σωστά στον υπολογιστή σας. 

Υπό φυσιολογικές συνθήκες θα έχει δημιουργηθεί μια νέα COM θύρα τον αριθμό της οποίας θα πρέπει να 

εισάγετε στο UCD ώστε να επικοινωνήσει με το Universalis. Αν η εγκατάσταση του C2S δεν έχει γίνει κανονικά 

ενδέχεται να χρειάζονται drivers. Αναζητήστε τους στο συνοδευτικό CD ή επικοινωνήστε με τη Charmeg.  

Για να προετοιμαστεί το Universalis να λάβει εντολές και προγραμματισμό από το PC πρέπει να βρίσκεται σε 

κατάσταση προγραμματισμού. Αυτό γίνεται θέτοντας το σε κατάσταση OFF και εν συνεχεία εκτελώντας τα 

ακόλουθα βήματα. 
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1. Πατήστε το πάνω πλήκτρο 

2. Πατήστε το κάτω πλήκτρο 

3. Αφήστε το πάνω πλήκτρο  

4. Αφήστε το κάτω πλήκτρο 

Αμέσως στην οθόνη θα εμφανιστεί η ένδειξη «===». Συνδέστε το Universalis με τη συσκευή C2S. Πρέπει η 

ένδειξη να μετατραπεί σε μια σειρά από ανάποδα «C». Αυτό δείχνει ότι το Universalis έχει πλέον συνδεθεί με 

το C2S. 

Για να βγείτε από την κατάσταση προγραμματισμού πατήστε απλά το κάτω πλήκτρο. Η συσκευή Universalis 

αρχίζει αμέσως να εκτελεί το νέο πρόγραμμα που εισάγατε. 

Λειτουργία UCD 

Εκτελέστε το λογισμικό UCD από το εικονίδιο που εγκαταστάθηκε αυτόματα στο μενού «Έναρξη». Αμέσως 

εκκινείται η αρχική οθόνη του λογισμικού. Ακολούθως εμφανίζεται η πρώτη οθόνη λειτουργιών. 

 

Στην αριστερή της πλευρά εντός πλαισίου φαίνονται οι βασικές παράμετροι επικοινωνίας. Για να τις αλλάξετε 

μεταβείτε στο μενού “Parameters”. Σώστε τις νέες παραμέτρους. Η παράμετρος που σας ενδιαφέρει κυρίως 

είναι η “Port”. Καθορίζει τον αριθμό της σειριακής θύρας στην οποία έχετε συνδέσει τη συσκευή C2S. 

Πατήστε το κουμπί “Connect and Login”. Εάν έχετε επιλέξει τη σωστή θύρα θα εμφανιστεί η επόμενη οθόνη 

εισαγωγής του κωδικού ασφαλείας. 
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Εισάγετε τον σωστό κωδικό και πατήστε “Login”. Αν όλα έχουν πάει καλά θα λάβετε σχετικό μήνυμα και το 

πράσινο LED του Universalis θα αρχίσει να αναβοσβήνει.  

ΠΡΟΣΟΧΗ! Για λόγους ασφαλείας το Universalis μένει στην κατάσταση προγραμματισμού αναβοσβήνοντας 

το πράσινo LED για κάποια λεπτά της ώρας περιμένοντας εντολές. Εάν δε δεχθεί καμία εντολή βγαίνει από 

την κατάσταση αυτή και περιμένει εκ νέου κάποιος να συνδεθεί με τη διαδικασία “Connect and Login”. Το 

λογισμικό UCD δε διαθέτει καμία ένδειξη για το ότι η συσκευή Universalis έκλεισε λόγω παρατεταμένης 

αδράνειας τη σύνδεση.  

Όταν ο κωδικός σας αναγνωριστεί έχετε πλήρη πρόσβαση στις λειτουργίες του UCD. Ξεκινήστε από το μενού 

Tools>Universalis Configurator. Η παρακάτω οθόνη πρέπει να εμφανιστεί. 

 

Η οθόνη διαιρείται σε 8 καρτέλες. Κάθε καρτέλα ρυθμίζει τις παραμέτρους ενός είδους δομικού λίθου. Στην 

εικόνα του παραδείγματος φαίνονται οι 8 λίστες τιμών για τη μοναδική παράμετρο του κάθε δομικού λίθου 

THERMOSTAT. Κάτω ακριβώς υπάρχουν 2 κουμπιά. Το “Write” μεταφέρει τις τιμές στο Universalis και το 

“Read” διαβάζει τις αποθηκευμένες τιμές από το Universalis και τις δείχνει στην οθόνη.  

Για λόγους ασφαλείας υπάρχει και μία μικρή ένδειξη επιβεβαίωσης στην περίπτωση που εκτελέσετε τη 

λειτουργία “Write”. Εάν όλα εκτελεστούν σωστά η ένδειξη γίνεται “OK”. Εάν όχι τότε εμφανίζεται το μήνυμα 

“ERROR”. 

Κάθε αλλαγή που κάνετε σε οποιαδήποτε καρτέλα πρέπει να μεταφερθεί μέσω “Write” στο Universalis.  

Κάτω από τις καρτέλες υπάρχει πλαίσιο με κουμπιά γενικών λειτουργιών. Από αυτά το “Read all” διαβάζει τις 

τιμές από όλες τις καρτέλες και τις εμφανίζει στην οθόνη. Είναι χρήσιμο στην περίπτωση που επιθυμείτε να 

δείτε ποια είναι η διαμόρφωση του Universalis με μια κίνηση. 
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Η επιλογή “Clear all” όπως και η “Reset” είναι ανενεργή στην παρούσα έκδοση του προγράμματος. 

Η επιλογή “Write all” εγγράφει στο Universalis τις τιμές όλων των καρτελών εκτελώντας πλήρη 

προγραμματισμό του.  

ΠΡΟΣΟΧΗ! Το “Write all” θα εγγράψει τις παραμέτρους όλων των δομικών λίθων με τις επιλογές που θα 

βρει στις αντίστοιχες καρτέλες. Πριν το πατήσετε βεβαιωθείτε ότι έχετε ελέγξει τις παραμέτρους αυτές για 

την ορθότητά τους. 

Από την οθόνη “Universalis configurator” μπορείτε πηγαίνοντας στο μενού File>Load ή File>Save As να 

αποθηκεύσετε τις τιμές των παραμέτρων του Universalis για μελλοντική χρήση ή τροποποίηση. Οι τιμές 

σώζονται σε αρχείο κειμένου με την κατάληξη “.set”.  

Αρχικές τιμές 

Το λογισμικό UCD επιτρέπει να καταχωρηθούν στο Universalis και οι αρχικές τιμές που επιθυμεί ο χρήστης. 

Υπενθυμίζεται ότι οι αρχικές τιμές διαφέρουν από τις παραμέτρους κατά το ότι οι παράμετροι καθορίζουν τη 

μορφή, τη δομή και τη λειτουργία του Universalis ενώ οι τιμές χρήστη και οι αρχικές τιμές τους είναι οι 

μεταβλητές που μπορεί και ο τελικός χρήστης να αλλάζει κατά τη διάρκεια λειτουργίας της συσκευής. 

Για να ρυθμίσετε από το UCD τις αρχικές τιμές μεταβείτε από την κεντρική οθόνη στο Tools>Universalis Initial 

Values.  Η επόμενη οθόνη εμφανίζεται. 

 

Η σημασία των πλήκτρων είναι ίδια με αυτή που εξηγήθηκε σε προηγούμενο εδάφιο.  

Οι αρχικές τιμές είναι οι τιμές των P00 έως P17. Ανά 2 αναφέρονται σε κάποιον δομικό λίθο THERMOSTAT. 

Δηλαδή η Ρ00 και Ρ01 ανήκουν στον TMC-1 οι Ρ02 και Ρ03 στον TMC-2 κλπ. 
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Οι αρχικές τιμές των τιμών χρήστη CC0 έως CC9 δε χρησιμοποιούνται στην παρούσα έκδοση του 

προγράμματος.  

Όπως προαναφέρθηκε οι τιμές χρήστη μπορούν να αλλαχτούν και εκ των υστέρων μέσα από το μενού 

ρύθμισης του Universalis. 

Παραδείγματα 

Παράδειγμα 1 

Ζητάμε να προγραμματίσουμε το Universalis ώστε να υλοποιεί έναν τριπλό θερμοστάτη θέρμανσης με 3 

αισθητήρια και 3 εξόδους ρελέ και 3 ενδείκτες LED. Η οθόνη θέλουμε να απεικονίζει μόνιμα τη θερμοκρασία 

του πρώτου αισθητηρίου. 

Για να υλοποιήσουμε τον τριπλό θερμοστάτη χρειαζόμαστε 3 εισόδους αισθητηρίων (S), 3 δομικούς λίθους 

θερμοστατών (TMC), 3 δομικούς λίθους ρελέ (R), 1 δομικό λίθο οθόνης (Display) και 3 δομικούς λίθους 

ενδείκτη (LED). 

Οι παράμετροι για κάθε δομικό λίθο είναι οι παρακάτω. 

S1=RSxx1K5, S2=RSxx1k5, S3= RSxx1k5 

TMC_1=S1, TMC_2=S2, TMC_3=S3 

R1=TMC_1, R2=TMC_2, R3=TMC_3 

LED1=TMC_1, LED2=TMC_2, LED_3=TMC_3, Display=S1 

Παράδειγμα 2 

Ζητάμε να προγραμματίσουμε το Universalis ώστε να λαμβάνει θερμοκρασία από ένα αισθητήριο υψηλής 

θερμοκρασίας και να μας δίνει έξοδο ρελέ όταν η θερμοκρασία αυτή είναι μεγαλύτερη από 100˚C και 

μικρότερη από 130˚C. Η έξοδος θέλουμε να συνοδεύεται από ένδειξη σε LED και η οθόνη να δείχνει την 

τρέχουσα θερμοκρασία του αισθητηρίου. 

Για να υλοποιήσουμε τον αυτοματισμό χρειαζόμαστε 1 δομικό λίθο αισθητηρίου (S), 2 δομικούς λίθους 

θερμοστάτη (TMC), 1 δομικό λίθο λογικού «ΚΑΙ» (AND), 1 δομικό λίθο ενδείκτη (LED), 1 δομικό λίθο οθόνης 

(Display). 

Οι παράμετροι για κάθε δομικό λίθο είναι οι παρακάτω. 

S1=KSxx1k0 

TMC_1=S1, TMC_2=S1 

AND_1= (TMC_1, TMC_2) 

R1=AND_1 

Display=S1 

P00=99, P01=100, P02=130, P03=129 
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Παρατηρήστε ότι στις αρχικές τιμές του TMC_1 είναι μικρότερη η πρώτη και μεγαλύτερη η δεύτερη ενώ του 

TMC_2 αντίθετα. Αυτό συμβαίνει διότι θέλουμε ο πρώτος να ενεργοποιείται για θερμοκρασίες > των 100˚C 

(θερμοστάτης ψύξης ή άνω ορίου) ενώ ο δεύτερος για θερμοκρασίες < των 130˚C (θερμοστάτης θέρμανσης ή 

κάτω ορίου).  

Παράδειγμα 3 

Ας εξετάσουμε τώρα ένα πραγματικό πρόβλημα όπως αυτό εμφανίζεται συχνά σε εγκαταστάσεις 

ηλιοθερμίας. Υποθέτουμε ότι υπάρχει ένα συλλεκτικό πεδίο και 2 θερμοδοχεία (boilers). Θέλουμε η συσκευή 

Universalis να διαμορφωθεί έτσι ώστε να φορτίζει το πρώτο θερμοδοχείο κατά προτεραιότητα μέχρι την 

επιθυμητή θερμοκρασία και μετά να φορτίζει το δεύτερο. Εάν η θερμοκρασία του πρώτου είναι κατώτερη 

ενός ορίου τότε να ενεργοποιεί τον καυστήρα (γενικά τη βοηθητική πηγή) και να φορτίζει το θερμοδοχείο 

αυτό με τη βοήθειά του. 
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Θα χρειαστούμε τους εξής δομικούς λίθους.  

• 4 αισθητηρίων θερμοκρασίας (S) 

• 4 θερμοστάτη (TMC) 

• 2 «ΚΑΙ» (AND) 

• 1 «ΟΧΙ» (NOT) 

• 3 ρελέ (R) 

• 3 ενδείκτες (LED)  

• 1 αριθμητικής οθόνης (Display) 
 
Ο TMC_1 είναι διαφορικός θερμοστάτης μεταξύ του αισθητηρίου του συλλέκτη και του πρώτου boiler. Ο 

TMC_3 είναι απλός θερμοστάτης που ελέγχει εάν η θερμοκρασία στο πρώτο boiler έχει φτάσει στο επιθυμητό 

επίπεδο φόρτισης. Εάν όχι τότε η έξοδός του αντιστρέφεται και δίδεται στο AND_1. Αν και οι δυο είσοδοι 

είναι ΟΝ τότε ενεργοποιείται το R1 και το LED1. 

Ο TMC_2 είναι διαφορικός θερμοστάτης μεταξύ του αισθητηρίου του συλλέκτη και του δεύτερου boiler. Η 

έξοδός του δεν πηγαίνει απευθείας στο R2 αλλά πρώτα στο AND-2. Εκεί φτάνει και η πληροφορία μέγιστης 

φόρτισης του πρώτου θερμοδοχείου όπως αυτή αναγνωρίζεται από τον TMC_3. Αν το πρώτο boiler έχει 

φορτιστεί πλήρως και το υπάρχει η αναγκαία διαφορά θερμοκρασίας μεταξύ του συλλέκτη και του δεύτερου 

boiler τότε ενεργοποιείται  το R2 και το LED2. 

O TMC_4 διαπιστώνει εάν υπάρχει ή όχι το αναγκαίας θερμοκρασίας νερό εντός του πρώτου boiler. Αν δεν 

υπάρχει ενεργοποιείται ο καυστήρας μέσω του R3 και ταυτόχρονα ανάβει το LED3. 

Η αριθμητική οθόνη ρυθμίζεται ώστε να δείχνει μονίμως τη θερμοκρασία στο πάνω μέρος του πρώτου boiler.   

Οι τιμές των παραμέτρων για κάθε δομικό λίθο είναι οι παρακάτω. 

S1=KSxx1k0, S2=RSxx1k5, S3=RSxx1k5, S4=RSxx1k5 

TMC_1= (S1-S2), TMC_2=(S1-S3), TMC_3=S4, TMC_4=S4 

AND_1= (TMC_1, NOT_1), AND_2= (TMC_2,TMC_3) 

NOT_1=TMC_3 

LED1=AND_1, LED2=AND_2, LED3_TMC_4, Display=S4 

R1=AND_1, R2=AND_2, R3=TMC_4 

Ενδεικτικές αρχικές τιμές της εφαρμογής είναι οι ακόλουθες. 

Ρ00=8, Ρ01=10, Ρ02=8, Ρ03=10, Ρ04=65, Ρ05=70, Ρ06=50, Ρ07=45 

 

Εκδόσεις και Συμβατότητα 

# Universalis firmware UCD version UCD User’s Guide Remarks 

1 201 1.01 UCD_gr_1.docx  

2 201 1.11 UCD_gr_2.docx  

3 203 1.12 UCD_gr_3.docx  

 


